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Unit 1
P.9 Introduction and checklist

Every unit begins with a short description of the unit project and the computer skills that students will learn in the unit. In this first unit, there is no project. It is simply an introductory unit to have students get used to the computer. After they are finished the unit, you can have them check off all the checkboxes.

P.10 Parts of the computer

It is best to let the students explore these items first. In this way, they will locate the parts on the computer and become familiar with it. Some of them are clearly less important than others. For example, in most classrooms you will not be using the card slot. You may choose to dictate the answers to students after their exploration, but keep in mind that the aim of this activity is simply to familiarize students with the computer. In recent years, as more students have computers at home, this is becoming less necessary, so you may choose to skip this page and several other pages in Unit 1.

1. DVD/CD drive

2. Power indicator

3. Card slot

4. Video port/ IEEE1394 port

5. Headphone jack

6. Speaker jack

7. USB ports

8. Power switch

9. Mouse

10. Keyboard

11. Display/monitor

P. 11 How to switch on the computer

Show students where the power button is on the computer. Have them write notes as some of them may forget how to do it on the following week. In addition, it is good to get them into the habit of writing notes. 

1. Power indicator

2. Power switch

p. 11 How to switch off the computer

You may like to do this section at the end of class when you want students to switch off the computer before leaving. It is important to teach students how to shutdown and turn off the computers properly. Turning off a computer forcibly by pulling the plug or pressing the power button for a few seconds will certainly cut off the power, but these methods can damage the hard disc or other parts of the computer.  For Windows, show students how to choose the ‘Shutdown’ option from the Start menu. 

P.12 Logging in to the computer

In your computer lab, many students will probably use the same computers by logging in with different usernames. Their data and settings are generally stored on the university server rather than on the local computer hard disc. 

The exercise has blanks for both Username and Password, but as the hint box implies, writing down their password is not a good idea. Doing this exercise will make them think more deeply about issues of security. If any students do write their password, you can make a joke about what you could do with their password. 

P. 12 The login screen

Because many computer systems have different login procedures, it is difficult to give general advice here. Instead, the exercise asks students to draw a picture of the login screen and to note the necessary settings. This will act as a reference for them in the next class when some of them may have forgotten. Throughout the book, keep in mind that the book becomes a reference guide as students fill in notes on many different features.

P. 13 The mouse

Most students will already have experience in using a mouse, but may not know the parts, especially the function of the right button or the scroll button. You can demonstrate the use of the mouse by opening MyDocuments or other folder. Start a demonstration by showing simple movement of the mouse. Also, show the tip boxes which appear if you point the mouse at an icon for about one second. These tips are very useful to students in making their notes throughout the book. 

1. left button (used for left click and double click)

2. scroll button (used to scroll through webpages and other documents)

3. right button (used for right click; this brings up context-specific submenus in most applications.)

P. 14 For Windows users

1. My Computer (used by the computer to store applications, settings etc.)

2. My Documents (used by the user to store files, music, video etc.)

3. Microsoft Excel application icon (the actual icons on the desktop will probably depend on the server configuration. If users are able to add their own icons, you can show them how to add a shortcut for the applications that they will be using most frequently.)

4. Microsoft Word application icon.

5. Desktop (or a cloud!)

6. Start menu (this is used to launch applications, to open control panels or for other functions such as to shutdown the computer).

7. Window

8. Recycle bin (used to trash unneeded documents).

9, 10, 11. Language setting and control panel icons (depending on your server configuration, these may vary).

12. Clock

P. 15 For Macintosh users

Most students will probably be using Windows, but if a Macintosh is available, it is good to introduce the features of the desktop and explain that Excel files are compatible between Windows and Macintosh. 

P. 16 Opening and closing a window

Open a window by double-clicking the My Documents or other icon. Explain the use of the three icons at the top right of each window. 

Minimize: This minimizes the window and sends it to the bottom of the screen where it becomes a tab.

Maximize: This maximizes the window so that it fills the screen as much as possible.

Close: This closes the window.

P. 16 The scroll bars

Again, open a window to demonstrate the use of the scroll bars. Note that all the scroll bars may not appear if the window is large enough to display all the data within it. 

1. Moves up within a window.

2. Moves right within a window.

3. Moves down within a window.

4. Next page (actual use may depend on application).

5. Jump (allows the user to different parts of the document or other documents). 

6. Next page (actual use may depend on application).

As a reminder, have students point the mouse at each of these scroll bar items to show them that a tip box appears. 

P. 17 Storing data

Explain to your students how they should store their data for the course. In most cases, it is best to recommend a USB key disc. These are cheap, portable, and store large amounts of information. In some cases, it may be possible for students to save their files onto the server. Be sure to remind students constantly about the importance of backing up data. 

P. 18 Opening Excel

Show the students how to open Excel from the Start menu or a desktop icon if available. If no desktop icon is available, show them how to make a shortcut. However, depending on the server configuration, all desktop icons may be reset after the computer is restarted.

Unit 2

Thematic Focus: Start an (imaginary) business and make a business plan

This is a vital unit as students begin their own (imaginary) company which they will manage throughout the entire course. You should motivate them to think about the type of company seriously as the idea should be strong enough to maintain interest. Remind them about entrepreneurs like Bill Gates and Dell who started up companies while they were still in university and went on to become some of the richest people in the world.

Skills Focus: This unit is an easy introduction to the uses of Excel and making changes to existing documents.

P. 20 Uses of Excel

Excel is used in many different ways. It is an extremely versatile program. Tell students that they will probably be using it in their future and that it is an important skill for their career. The book lists some standard uses such as keeping records, doing basic layout, keeping accounts, and making charts/graphs. Students may not be able to think of other uses at this point in the course, but as with all exploration and thinking areas in the book, encourage them to return later to add more information. 

P. 21 Creating a workspace

Open Excel on your own computer and display it to students. Explain that this is the basic screen for Excel. Demonstrate the labeled parts 1-10 using the following names. These words are also shown in the list in the textbook in a jumbled order. Have students write the English names. If your students’ version of Excel is not English, you may also like to have them write the names in their own language.

1. rows
2. columns
3. cell (selected cell)

4. entry / formula bar

5. menu bar (this item is missing from the list in the textbook; ask students to add it by hand)
6. Standard toolbar and Formatting toolbar (the formatting toolbar appears on the right hand side of the Standard toolbar in this picture. Later, students will learn how the position and shape of these toolbars can be changed. 
7. Graphical toolbar

8. Operation pane

9. worksheet

10. cell address (students will later learn how to use this to describe a range of cells)

P. 22 The File Menu

The file menu is one of the most commonly used menus, but is also straightforward to understand. It is used for creating new files, for opening and closing files, for saving, printing and some other functions. Students will need to use the File menu for the activity on page 23. A brief introduction of its purpose is sufficient at this point. Do not spend too much time on the File menu now as students will get plenty of practice in the rest of this unit and subsequent units. They should come back and write explanatory notes later when they have used all the functions in the menu.

P. 23 Opening a document

Before class, you should check that the sample file downloads smoothly onto student computers. If the Internet connection is not adequate, prepare a copy of the file on a USB disc so that students can copy it on to their own computers easily. 

Be sure that students download and save the sample document onto their own computer or USB disc. Warn them not to try to open it directly from the Perceptia Press website as this will not save it onto their own computer. 

Once they have saved it, 

The sample document is a business plan which students can alter to create their own business plan without learning more than the fundamentals of data entry. It has three different worksheets. Worksheets allow users to store different data or even different kinds of data within a single file. 

Interview: This worksheet asks some basic questions and answers them. Students will carry out this activity for their own company on page 25.

Timeline: This timeline shows the projected development over time. Students will alter this information to reflect their projections about their company on page 25.

About the company: This worksheet shows the name of the business, the main product or services, and the company’s mission statement. Students will alter this information to match their own company on page 24.

P. 23 Moving around a worksheet

There are several ways to move around a workbook. Show students how they can use the arrow keys or simply move the mouse and click on a cell to make it active. 

P. 23 Using more than one worksheet

In the sample document, students will already have noticed how an Excel file can have more than one worksheet. Show students how you can change worksheet by clicking on the tab. In unit 6, they will learn how to change the name of a worksheet by clicking on the tab and how to manipulate them in other ways.

P. 23 Editing data in a cell

Show students how there is only one active cell at any time. Data in the active cell can be replaced by typing directly into the cell or by typing into the entry bar. This is termed the “formula bar” when it is used for entering formulas in unit 6 and 7.

For practice, tell students to change the data in some of the cells. Over the next few pages, they will develop information about their own company and eventually replace all of the data in the sample document.

P. 24 Choosing your business

Although this appears to be a short activity, you should give students enough time to come up with a viable idea for a company. This is a very important part of the book as they will use their imaginary business throughout the entire course. Pretend that you are a motivational speaker for a few minutes and really fire them up about the idea of becoming rich through their company. Use your imagination to tell them about all the wonderful things they could do.

· Ask them to decide the industry that they would like to work in. Catering, entertainment, education, and manufacturing are common choices, but encourage them to use their imagination. Other possible industries include tourism, publishing, agriculture, marketing, trading, fashion, and technology. Many students will try to take a simple option such as a restaurant. While this is fine as a final idea, ensure that they think through the possibilities of other businesses within the same industry. For example, if they want to set up a restaurant, suggest alternatives such as catering supplies or home-delivery food services.

· Next, ask students to choose their particular business within the industry. For example, businesses in the industry of fashion might include a clothes shop, a designer, a model agency etc.

· Students should now discuss their choice of business with other students. You may like to call on students to tell their idea to the whole class. This discussion will make students take their idea more seriously since it has become public knowledge within the class.

P. 24 Naming your business

The name of a company is very important. It should be short, easy to remember, and in general it should reflect the nature of the company’s business. 

· Tell students to think of five possible names for their business. This should be a fun activity and you may like to give them some funny examples such as “Tomo’s Donut Dream” or “Prettiest Publishing.” Be sure to keep a high level of enthusiasm. 

· Students should discuss the name with a partner or group and decide on the final name.

· Students should next write a mission statement which describes their core business. For example: “We want to fix computers faster and cheaper than anyone else in this city”, or “We will send parcels to any part of the world within 24 hours.”
P. 25 Making a business plan

A business plan is not only a necessity for any company, it is also a fun activity that provides plenty of language practice and helps students to take their business (and your course!!) seriously. The students draw the plan up on paper on page 25 and then enter it into Excel on page 28.

· Give them some time to fill in the answers to the questions. Mingle with the students and try to get them to write as much detail as possible. For example, in answer to the question “Where will you get that capital from?”, many students will write “bank”. Point out to them that the bank will need some kind of collateral and ask them to write more details. 

· There are two spaces in the book for writing their own question. They should think about what is important for a company and use this to write their own questions and answers. 

· The timeline is an important part of the business plan. You could ask students to look at the sample document and use that as the basis for their own plans. 

At all times, it is vital to keep the students enthusiastic and interested in the business. If you can do that successfully now, the rest of your course will be a pleasure to teach.

P. 26 Toolbars

· Show the students the list of toolbars available from the View menu

· Demonstrate how the toolbars can be turned on and off. 

· Move the standard toolbar to show that it is not fixed in place (many people never realize that this is a toolbar!). As the hintbox on page 26 says, a toolbar that has been dragged out is called a floating palette.

· Change the shape of the toolbar/floating palette. 

· If students are using a non-English version of the software, you can ask them to write the names of the toolbars in their own language in the spaces on 26, or you can have write an explanatory note in each of these spaces.

P. 27 The Standard Toolbar

Some people use the standard toolbar a lot for functions like saving, printing, cutting and pasting. Experienced users of Excel tend to carry out these functions using keyboard shortcuts, but it is certainly quicker to use the toolbar than to do everything through the menus at the top of the screen. 

· Briefly explain the function of each of the items in the standard toolbar and tell students to make notes in their book.

· Remind them that a little yellow help balloon pops up if they hold the mouse over one of the items in the toolbar.

· If your students are using a non-English version of Excel, you may like to have them write the names of each item (as they appear in the help balloons) in their book.

P. 28 Activity: Making a business plan in Excel

This is an excellent activity for letting students become familiar with the basic workings of Excel. They are simply replacing the data in the sample file (downloaded on page 23) with the information about their own business which they created on pages 24/25.

The instructions to the students are very explicit and like all of the activities at the end of each unit, this activity is ideal for homework. You should tell the students to complete it for the next class. They can print it out and paste/staple it into their book on page 28. At the end of the course, you can collect the books and check all of their work in this way.

P. 29 Knowing Your Customers

· Introduce the theme of the unit and explain to students that in this class they will begin to run their business in earnest. 

· Remind them about the checklist. It is not necessary to go through it in detail as students will not know what the items are yet, but be sure to remind them to check off each item as they learn about it or at the end of the unit.

P. 30 Creating a new document

Remind students how to make a new document. 

Explain how Excel is often used as a database. In this unit, they will use Excel to create an customer and supplier address book for their business. The final project is as always on the last page of the unit.

P. 30 Adding data

Demonstrate how data can be entered either via the entry bar (sometimes referred to as the formula bar) or alternatively how it can be typed directly into the cell itself. 

Move the mouse around and enter 'address' in A7 etc. 

Also, show them how they can enter the address of a cell in the Address Bar (it is normally on the bottom left of the formatting toolbar unless the toolbar has been moved. Explain that this is very useful in a very large document where all the data does not appear on the screen at the same time. 

P. 30 Entering other kinds of information

Enter the items in the textbook into cells. All of them have an unexpected result. For example, Excel will change '17 October' into something like 10-17 (the actual appearance will depend on the date settings in your preferences). Although these unexpected changes can be a little disconcerting, they are an attempt by Excel to help you by guessing what you want to do. As the students get used to Excel, this 'guessing' feature can be quite useful. 

It is possible to override the 'guessing' feature by putting an apostrophe before the entry. 

Example

Typing 09012345678 will produce 9012345678 because Excel is guessing that is an ordinary number rather than a telephone number.

But typing '09012345678 will produce 09076125413 because the apostrophe overrides the 'guessing' feature.

Note, if the number is typed as 090-1234-5678, Excel will correctly identify it as a telephone number. 

P. 31 Identifying your customers

This section is best carried out after the 'Formatting cells' activity below. 

Remind customers that they are making a customer database. The other students in the class are their first potential customers and in this activity they start to get data for their database. This is a speaking activity and you can allow students to move around the classroom collecting the information from other students.

P. 31 Formatting Cells

This is an important dialogue box as it controls how Excel formats the data in a cell. It can be opened by choosing Format > Cell, but it is much easier to use the shortcut (CTRL + 1).

As the tabs in the screenshot show, it can be used to format:

number (the type of number such as: currency, decimal, fraction, percentage, etc.)

alignment (the position of text within a cell)

font (the font and the size of the text)

border (lines around the cell used for emphasis)

patterns (a wide range of colours and patterns are available to fill cells)

protection (cells can be protected to stop the data being changed)

After introducing the format dialogue box, allow the students to explore it and to choose the best format for each of the items that they typed at the bottom of page 30.

This activity again shows students how to use the single quote (apostrophe) to override Excel's automatic formatting.

P. 32 Selecting

Have students practice dragging the mouse to select the ranges of cells given in the textbook. 

Show them how to select an entire column (by clicking on the A,B,C tabs at the top of the column - the cursor will change to an arrow)

Show them how to select an entire row (by clicking on the 1,2,3, tabs at the left of each row - the cursor will change to an arrow)

P. 32 Entering data in a range

By selecting a range of cells, it is possible to enter a range of data easily without using the mouse.

Select the cells C3-E6. 

Enter the words, one in each cell. Move between cells by pressing the Enter key. As long as you do not touch the mouse, the range of cells will stay selected and it is a very fast way of entering data. 

Show students what happens when you use the following keys:

Return: On Apple keyboards, this has the same function as the 'Enter' key and it moves onto the next cell in the selection

Enter: This moves onto the next cell in the selection. When it reaches the last cell in the range, it returns to the first cell in the range.

Shift + Enter: This moves to the previous cell. 

Tab: Whereas the Enter key moves vertically within the range, this moves horizontally within the range of cells. 

Shift + Tab: This moves to the previous cell horizontally.  

Walk around the room ensuring that students are not using the mouse to select each cell individually.

The hint box shows students how they can name a range of cells. This is useful if you want to label a particular section of the worksheet. However, it does have the disadvantage that the cell address is no longer shown and this can be confusing when you are making formulae (see chapter 5).

P.33 Moving and copying data

Drag

A single cell or a range of cells can be dragged by selecting it, grabbing it one of the sides with the mouse, and dragging the mouse. Note how the cursor changes into a cross-hairs (or a hand on Macintosh) when you are in the right position.

When you try to drag data into cells that are already occupied by other data, Excel will give you a warning dialogue box asking whether you want to replace the data in those cells.

Cut, Copy and Paste

These are such common commands that you should be sure that students learn the keyboard shortcuts. 

Copy: CTRL + C

Paste: CTRL + V

Cut: CTRL + X

Undo: CTRL + Z

P.34 Deleting and clearing data

The difference between 'delete' and 'clear' is not always clear (pun intended!) 'Clear' removes the data from a cell, but 'delete' removes the cell itself and moves other data to fill its place.

'clear' has several options 

· All: This clears all contents from a cell including data, format, formula and comments.

· Formats: This clears any formatting which has been applied to the cell but does not affect the content.

· Contents Del: This clears the contents of data and formulae.

· Comments: This only deletes the comments and leaves the data, formatting and formulae intact.

'delete' also has several options

The option determines how the other cells should move to fill in the place of the deleted cell.

P.35 Adjusting the size of rows & columns

When Excel opens a new worksheet, all the cells are exactly the same size, but they can be adjusted so that cells are different sizes. 

Using the Format menu

Choose Format > Column > Width and enter a different number. When you click OK, note how the size of the column has changed. This feature is useful when you want to set a column at a particular width. For example, you could use Excel to align text on a sales receipt and as certain sections might need to fit in with the rest of the page when it is printed, so you can use this function to set the width.

Demonstrate the same principle for row height using Format > Row > Height

Often, the exact height of the row or width of the column is not so important. In these cases, you can simply change the size of the row or column by dragging on the lines between the cells at the top (A,B,C) or left side (1,2,3) of the window.

It is also possible to automatically adjust the size of a row or column to match the data. To demonstrate, enter a long word like 'supercalifragilisticexpaleladocious'. Note how it spills over and obscures the adjacent cell. Now double-click the lines between the cell at the top and the column will automatically become wide enough to accommodate the data. You can do the same thing with rows.

A neat trick is to highlight all of the cells in a worksheet by clicking in the top left corner. Now, by clicking any of the cell lines at the top or left, you can automatically adjust the widths of all columns and heights of all rows to accomodate the data.

P.36 The Formatting Toolbar

The formatting toolbar is a convenient way to change font, font size and other common attributes. Show the students how the help balloon appears when you hold the mouse over the icons in the toolbar. Give them some time to explore the options and make notes in their book. 

P. 37 Floating Palettes

Many people are unaware that the toolbars can be pulled out to become floating palettes. In many cases, this makes them easier to use. Simply grab the left side of the toolbar to move it. Its shape can be changed in the same way as any other window – by dragging the sides of the window. You will know that the mouse is in the right place when the cursor changes into a double-ended arrow. 

P. 37 Changing the appearance of a worksheet

Fill colour
Demonstrate to students how to select a few cells and apply a fill colour by clicking on the Fill palette. It is much easier to choose an appropriate colour if you pull out the Fill palette. 

The Fill palette also allows you to apply patterns. Encourage students to explore the options as there is a rich variety of choices and using them can really improve both the appearance and readability of an Excel Worksheet.

Font Colour

Changing the font colour of text is very similar to changing the fill colour. Again, show students how to change it into a floating palette. Explain to them how some of the lighter font colours make text difficult to read, especially when the document is printed out. And of course, remind them not to use too many colours if they are printing in gray scale!

You may like to point out that the standard colours in Excel are quite dark and they can make text quite difficult to read. It is possible to change the standard colours in the palette by choosing Tools Remind students that the point of using colours is to communicate more effectively. It is not to make documents look pretty. 

Borders
Borders are an excellent way of separating different sections of data on a worksheet or highlighting a particular range of cells. For example, the totals of a list of costs can be highlighted with a border, so that someone can see them immediately. The catalogue on page 42 also shows the use of borders in separating different items from one another.

Excel offers many different kinds of border, but for most purposes, a grid or a simple solid line is generally the best choice.

P.38 Using the Format Cells dialogue box

Excel offers a huge range of format options for controlling the appearance of text and cells on a worksheet. Students have already learned about this dialogue box on page 31. At that time, they learned how to tell Excel what kind of number they want (currency, decimal, fraction etc.).  

Alignment

This allows you to set the horizontal and vertical alignment of text within a cell. 

An important (but not very prominent option) is ‘Wrap text’. In standard settings in Excel, if text is too long for a cell, it will not be completely displayed. By checking the ‘Wrap text’ box, you ensure that the cell will automatically increase in size and that all of the text will be displayed.

You can also change the orientation of the text. A good example of this can be seen by downloading the sample file, BusinessPlan.xls from the Perceptia Press website. The version in the textbook on page 23 does not show this text orientation, but it can be seen clearly on the sample file. Text that is orientated in this manner can make a better use of space on a worksheet, but also be much easier to read than completely vertical text.

Font
This offers a huge range of control on the font, text size, text colour and other effects such as underline, strikethrough etc. Have students explore the dialogue box and make notes.

P.39 Using the Format Cells dialogue box

This continues the exploration of the Format Cells dialogue box which was begun on p.38. 

Border

On page 37, students learned how to create borders with the border palette. Like many other features of Microsoft products, there is more than one way to carry out similar actions. In this case, the dialogue box offers many more options than the simple palette.While most of these options will never be necessary, give students a few minutes to explore and become familiar with them. 

Patterns
On page 37, students learned how to add fills and patterns with the Fill palette, but the dialogue box gives more control when they want to create something very specific. Be sure to have them click on the Pattern tab to see the range of interesting patterns that are available.

Protection

Sometimes, it is useful to be able to protect the contents of a cell so that it can not be accidentally overwritten by other data. Locking a cell will prevent this overwriting. ‘Hiding’ a cell will completely hide it from view so that it can be seen or altered. This could be used for hiding cells with formulae in them.

Note that locking cells or formulae has no effect unless the worksheet is protected.

P.40 Activity: Complete your database

This is the primary activity of the unit and is probably best assigned as homework. They have already started making their database on page 31 by adding their classmates as potential customers for their business. 

· Download the sample file from the website: AddressBook.xls. Use this to demonstrate the use of different worksheets for showing different categories of information. On page 60, they will learn how to change the name of a worksheet and how to insert new worksheets, but you may like to show them at this point, too.Alternatively, they can simply replace the information in the sample file with their own information.

· One of the worksheets should feature utilities such as gas, electricity, water and telephone. Another can feature suppliers.

· This activity is a good opportunity for students to practice using Fill, borders, and the other formatting options introduced in this chapter. Remind students that their business should have an image and that all of their worksheets should reflect that image. For example, they might decide to use red and green as their company colours, in which case these colours should feature in all of their worksheets and thus facilitate brand creation and identification.

· When students have finished, they should print out their work and paste or staple it into the textbook on this page. This allows the teacher to check the work easily and to suggest improvements to students when required. In addition, it builds up a portfolio of work that the teacher can refer to at the end of the course when grading students.

Unit 4

In this unit, students learn how to use Excel to make a catalogue or menu. It serves as a good introduction to the use of Excel as a layout tool. In addition, they learn useful formatting features of Excel such as adding borders and images. The project focus of the unit helps students to create a catalogue.

P.42 Using Excel for designing a catalogue

Have students look at the catalogue to see how the important information can be laid out using Excel. Explain that cells can be different sizes and these allow them to accommodate images or text as in this example.

P.43 Preparing your company catalogue

Have students look at the catalogue again and note the good and bad points. You may also like to prepare other catalogues for them to look at. Alternatively, there are many examples online. Encourage them to look at the formatting as well as at the content of the catalogue.

Doing the Interview

This is a conversation activity that helps students to focus on which of their products they will include in their company catalogue. It firms up many of the ideas which they had in the earlier units. The final part of the activity asks them to make a list of the products or services and to specify the prices. 
P.44 Sketching the layout of your catalogue

If students jump straight into using Excel, they are unlikely to develop a clear conception of what they want their catalogue to look like. This activity asks them to sketch it out on paper first. With any spreadsheet, this can be a good idea since it is much easier to design things right from the beginning than to try to change it later. After making the sketch, they are asked to make a list of the images that they will need. Ways of getting these images will be explained on page 45 and 46.

P.45 Adding images to your catalogue

Clip art

Demonstrate the use of the clip art library. Show how pictures can be dragged and dropped onto a document. They can also be double clicked. Show how the size and position of the images can be changed.

Scanned images

If you have a scanner available in your computer room, it can be very useful. Many students will enjoy drawing their own illustrations for their catalogues.

Photographs

While almost every student is likely to have a camera available on their cell phone, it is quite typical for them to have never printed them out. Explaining that they can email the photos from their phone to their regular email account and then use them on the computer. Alternatively, many cell phones now have small memory cards which can be read from a computer using a cheap adapter.

P.45 Getting images from the Internet

Google images is a marvelous and quick place to find images, but do warn students of copyright concerns. You may like to direct them to other sites which have freer copyright such as Copyright Control. Usually the image that appears in the search engine is just a thumbnail of the actual image. Be sure to show students how to navigate to the high quality image. They can download these images by dragging them to the desktop or a folder, or alternatively they can do a right-click and choose the save option.

P.46 Drawing tools

Using objects

Excel has a large collection of autoshapes that can be used to make interesting images. You can find some examples in the gallery sections of the Perceptia Press website. Show students how the palette can be pulled out to become freestanding. In addition, the individual palettes (Lines, connectors etc.) can also be pulled out for easy access.

Demonstrate the different types of line and freehand. If you aren’t familiar with them, be sure to practice yourself first as they give unexpected results.

The callouts (voice bubble) options are a great way for students to spice up a catalogue with comments from customers or used to let the products speak for themselves. 

P.47 Collecting your images

Give students a few minutes to gather all of their images into a single location, for example on their USB disc or network drive. It is important that students consider which images are most appropriate for their catalogue, so allow them to discuss their image choice with a partner. You may also like to call on a few students to explain their choice of images to the class. Remind all students that images are highly useful in a catalogue, but that too many images can lead to clutter. 

P.47 Making your catalogue


Have students refer back to the model catalogue on page 42, but allow them to also express their own creativity. Ensure that they add the names and prices for each item as these are essential in later units. Remind them how they learned how to adjust the size of rows and columns on page 35. Also, have them format the prices of products in the correct currency as they learned on page 31.

P.47 Importing images into your catalogue

At this point, students should have set up their basic design using row and column size, and by adding the product prices and names. In this section, demonstrate how to import images into an Excel workbook using the Insert command. You may also like to demonstrate how they may be dragged directly from an external folder. 

P.48 Fills, patterns, and borders

The use of fills and borders can really transform a simple design into a highly effective one. Patterns are often less useful, but can be used creatively. 

Demonstrate the use of the fill palette to students. Show them how the palette can be pulled out and moved around the screen to make it easily accessible. 

To hide the gridlines, you can either turn them off in the Preferences of Excel, or more impressively, select all the cells by clicking on the top left hand corner of the worksheet and then filling all the cells with white. 

Once the gridlines have been removed, demonstrate how adding borders serves to highlight important areas of the catalogue. Demonstrate the different kinds of border. Also click on the “Draw Borders…” button and show how borders can also be drawn manually.  

P.49 Word Art

Students usually love Word Art. Remind them at the beginning not to overuse it, as it tends to appear on too many poor designs already, but it certainly is a useful feature especially if students learn to customize it to make their style unique. 

Demonstrate how the Word Art dialogue box is opened by clicking on the icon in the Drawing toolbar, or it can also be added using the Insert menu. Quickly show how the style of the text can be changed by selecting the different styles available. Also show how the font and character size can be changed. 

If time is available, show students how to customize the Word Art. 

The size of the Word Art can be changed by dragging the nodes at the corners or sides. Note that these will distort the Word Art. In other words, the horizontal and vertical change in size will probably not be the same. Hold down the shift key while dragging to keep the horizontal and vertical changes in size proportional. 

You can create a clever reversed text effect by dragging the size of the Word Art down to zero and keeping dragging. This is easier to demonstrate than to explain! Try it out. 

Most styles of Word Art have an additional node (yellow in most versions of Excel) which can be used to change the angle of slope of the text or its rotation around a fixed point. Using this node creatively can allow students to create truly unique Word Art. 

P.50 Making a company logo with Word Art


In this section, students make a company logo to use in their catalogue and other materials. Have students produce at least three different styles of logo and paste them in their books. This provides excellent practice in using Word Art. Ensure that students are exploring the various options available. 

Next, have students revisit the company slogan that they made on page 24. As them to create this slogan in a different Word Art style. If the slogan is too long, they may need to shorten it to make it look good. Have them combine the two pieces of Word Art. You can also demonstrate how they can group the items using the Group command (available as a right click if they select both items). 

P.51 Printing in Excel

There are a huge number of printing options available in Excel, and it is best to keep this section simple to avoid overwhelming students. Here are a few of the important points;

- Show them how to change the size of the margins using the Page Setup dialogue box.

- Show how you can select a particular area of the worksheet to print by choosing Print Area. 

- Demonstrate how they can select a particular printer using the Print dialogue box.

- Show how they can change the orientation of the page from vertical (Portrait) to horizontal (Landscape). This will allow them to make the best use of the paper. 

- Before they print, encourage them to use the Print Preview command to ensure that it is setup exactly the way that they want it.

Warn students to only print once as there will often be cases where students attempt to print again and again as the mountain of paper piles up across the room!

P.52 Printing your catalogue

In this section, students should complete their catalogue, print it out, and paste it into their textbooks. 

You may like to assign this for homework. 
Unit 5

This unit gets to the heart of Excel, its uses in recording and manipulating numbers. Unit 5,6 and 7 explore many of the important number-handling functions of Excel. These units build upon each other. For example, unit 6 uses the worksheet that students have developed in unit 5, so it is important to ensure that students are keeping up. On the website, you can find the sample worksheets for the imaginary company, Jeepers Jam. These are useful for crosschecking that the worksheets are correct. In units 5-7, students first follow the example for Jeepers Jam and then they apply the same procedures to their own companies.


In unit 5, students learn how to record sales for their company. These are imaginary sales, so you will need to have them use their imaginations. Talk about ‘getting rich’ is generally successful in getting people to think in this way! You may also like to have them close their eyes and imagine how they will spend all the money that they are going to make from their company. 


The skills focus of this unit teaches students how to input data manually and by autofill, to calculate totals, to adjust rows and columns and many other related functions. 
p.54 Planning the worksheet
It is a good idea to sketch out a worksheet on paper before beginning to design it in Excel. This will allow you to make the spreadsheet most efficient. This section shows an example for Jeepers Jam. Later, students will imagine the same information for their own company.

Setting up rows and columns

 This section and many of the following sections contain cell references. While these may be considered arbitrary, it is easier to use these exact references as all of the formulae in the book refer to them. In addition, the sample files on the website use the same cell references.

The instructions for setting up rows and columns are in the textbook.

Using Autofill

Autofill is an extremely useful function of Excel that is overlooked by many users. It allows you to enter the first item(s) in a series and to allow Excel to intuitively fill in the rest of the series. To use autofill, put the cursor in the corner of a cell which has data in it. The shape of the cursor will change. Now, if you drag the cursor through adjacent cells, they will automatically be filled with data. Until you get used to Autofill, Excel may sometimes surprise you with the data that it fills in. This section gives students an opportunity to explore Autofill with different types of data in order to get used to it.
p.55 Inputting data
Using a selected cell range

If you select a block of cells with the mouse, it is easy to enter data in only that range using the enter key. Demonstrate for the students.

Using the number keys

It is far faster to enter numerical data with the number keys than with the regular keyboard. As with the regular keyboard, there is a small bump on one of the keys which will help you to orient yourself on the number keys even if you are looking at the screen. 
Speed contest

Set this activity up as a fun race in which students try to enter the data as quickly as possible. It provides good practice for using a selected cell range. As you walk around the classroom, you will probably notice that many students are not using a selected cell range, so point it out to them. 
The Number Lock

The number lock key sometimes gets pressed by accident and that can cause students to think that the keyboard is broken. Demonstrate the position of the number lock key and the light that appears on the keyboard when it is pressed down (may not appear on all keyboards.) In addition, when num lock is on, it will generally be shown on the bottom right hand corner of the Windows display.
p.56 Adding rows and columns
This section shows how to add rows and columns. This is important to help students make their worksheet more readable. 
p.56 Making totals automatically
Simple summing using the Sigma icon

Excel is pretty smart sometimes. If you press the Sigma key in a cell below a column of numbers, it will automatically add them up and place the total in that cell. You can find the Sigma key in the Standard toolbar. 
Autofill with sums

Autofill can be used to generate the totals, too. Just drag the cell that you have placed the total in. When you generate multiple totals like this, demonstrate it to students as it can have a real ‘wow’ factor! 
Calculating the grand total

To calculate the grand total, students get their first introduction to formulas. These will be explored in more detail in later units. Since Excel is not clever enough to calculate the grand total, students much enter the formula =D9+D14. The “=” sign denotes the use of a formula and it is must be entered. Otherwise, Excel will interpret “D9+D14” as text.
p.57 Formatting your worksheet
Have students look back at earlier units to see how to remove the gridlines etc. Also, demonstrate any of these functions which have not been learned before. This is a good opportunity to demonstrate the many functions on the Formatting toolbar.

Adding a title

Demonstrate the use of the “Merge and Center” button. You can find this in the Formatting toolbar. Simply select multiple cells and press the button. This is also a good time to review the “Format cells” dialogue box.

By now, students should have a completed worksheet that looks like the one on the bottom of page 57. Have them check that their totals are the same as the picture. If not, they may need to look at the formulas again to figure out what is wrong. A copy of this file is also downloadable from the website.

p.58 Activity: Make your sales projections
In this activity, students make their own sales projections. The final result should look something like the sales figures on the bottom of page 57. Encourage students to use their imagination to think about future sales. You can do it over a timescale of days, months or even years. When they are finished, have them print their sales projection worksheet and paste it into their books on page 58.
Unit 6

In unit 5, the students set up their sales worksheet. In this unit, they will learn about a central feature of Excel: calculations. This unit also introduces them to how to use Excel for basic accounts.

P.60 Making accounts


This section simply explains the purpose of this unit.
P.60 Working with multiple worksheets

An Excel document can have many worksheets. These are useful for storing different kinds of information. All the data on any worksheet can be referred to anywhere within the document, so worksheets are a very useful way of organizing data. In this section, they rename the worksheet that they set up in Unit 5 as “sales”. Then they add new worksheets for “prices” and “income”. Knowing the sales and the prices, it is easy for them to have Excel automatically calculate the income. 

Here are some useful features of worksheets.

· You can move to a different worksheet by clicking on the worksheet tab at the bottom left of the window. 

· You can change the name of a worksheet by double clicking it and entering the new name. 

· A right click on the worksheet tabs will also bring up a contextual menu that makes it easy to make changes. 

· You can move a worksheet by dragging the tab. 

· You can copy it using the right click contextual menu, or by dragging while holding down the ALT key.

· You can also make changes to worksheets using the menus.

P.61 Adding your prices

As usual, students first work with the Jeepers Jam data before making worksheets for their own companies. Here, they are using the prices for Jeepers Jam products which are shown in the textbook (In Unit 4, students should have decided prices for all of their own products.) 

· Have them copy the names of the items from the sales sheet rather than retyping them. Apart from avoiding errors, this also gives useful practice at transferring data between different worksheets.

· Have them enter the prices and format the cells to show the appropriate currency and number of decimal places. You may need to review the use of the Format Cells dialogue box. 
P.61 Basic mathematical calculations

In this section, students first explore the basic mathematical calculations in a separate worksheet. You may like to demonstrate all of these functions or allow students to explore and discover them. Depending on time available, you can also show them more complex calculations. Here are the symbols for the simple calculations. 

· Addition: +

· Subtraction: -

· Multiplication: *

· Division: /

Show them how they always need to include the ‘=’ sign in order to have Excel interpret the formula correctly. 

If you have time, you might like to have students design a simple calculator. This is a fun activity that reinforces the use of basic mathematical calculations. An example is available on the Perceptia Press website.

P.62 Calculating the income

As this is a little tricky, the instructions are given in full in the textbook.

Referring to a fixed cell

This is a tricky area that you should be sure you understand yourself clearly before attempting to demonstrate it to students. Autofill is not always as smart as you would like and in this case, it does not realize that the price is always in the same cell, so we must set this manually. 

By using the “$” symbol before a cell reference, Excel will interpret that the cell reference is to a fixed cell and will take that into account when it carries out Autofill. Be careful to tell your students that the “$” sign is nothing to do with money. This can be a little confusing, so make it clear!

P.64 Activity: Complete your company accounts

In this activity, students should calculate the income for their own company. They should end up with a set of worksheets that look similar to the ones for Jeepers Jam. Sample files are available for download from the website. As usual, students should paste their work into the textbook.
Unit 7

This unit continues to help students develop their imaginary company. They learn about some other important features of Excel including conditional formatting, and other functions such as Max and Min. As with Unit 5 and Unit 6, it is important that students follow the cell references exactly.

P.66 Using Conditional Formatting


Take a few minutes to demonstrate the use of the conditional formatting dialogue box. Conditional formatting allows Excel to recognize if a particular condition has been fulfilled, and if so, to format the selected cell(s) in the selected manner. There are many options available for the conditions. In addition, there are many formatting options such as font, colour etc. 

Enter the example from the textbook and demonstrate how the format of the cell changes according to the number in B4.

Show students how they add more than one condition by pressing the ‘Add’ button’ or how they can remove a condition by pressing the ‘Delete’ button.

P.67 Using Logical Functions


Logical functions care a powerful tool in Excel. They allow you to create if-then statements that allow Excel to respond to a wide variety of possible conditions. 

Logical functions can become quite complicated and the formatting must be exactly right, so be sure that students copy the examples exactly from the textbook, or they are likely to get an error. If they make a mistake, for example, by omitting parentheses, Excel may sometimes try to guess the intended formula and make a suggestion. 

Logical functions take the form:

=IF (CONDITION, THEN DO THIS, ELSE DO THIS)

On page 67, you can see the example:

IF (B4<20, “Buy more stock now! You need an extra ”, & 20- B4, “OK”)

Notes:

The condition is: If the value in the cell B4 is less than 20 

The action is to print the combination of the message “Buy more stock …” and the calculated remaining stock (20 – B4). This is printed in the cell where the logical function has been placed.

If the condition is not true, the message “OK” is printed in the cell where the logical condition has been placed. 
P.67 Calculating averages

Here, the students calculate the average stock required each month. Demonstrate the Average function to students. 


P.67 Using division to calculate daily stock

On page 61, students learned how to do basic mathematical calculations. Here, they use division to calculate the stock required each day. For simplicity, it is assumed that there are 30 days in each month.


P.68 Showing your best selling product

This is a tricky procedure, so be sure to follow the example in the book closely. 


P.69 Introducing other functions


Depending on time available, demonstrate some of the other functions available in Excel. There are many functions and these can be extended by adding special add-ins for particular purposes such as statistics. Also demonstrate the Insert Function dialogue box which offers more options.
P.69 Using Paste Special


The Paste Special dialogue box is only tangentially related to the use of functions. It is a powerful way of controlling how objects are pasted from the clipboard into Excel. It is useful to demonstrate its existence, but the large number of options may confuse some students.
P.70 Best sellers and poor sellers


Have students carry out the same calculations using the data from their own imaginary company. They will need to base it on the worksheets that they have developed in the preceding units. Tell them to print it out and paste it in their books on page 70.

Unit 8

Charts and graphs are generally interchangeable terms. Excel can produce these charts very easily and they can often show information much more effectively than columns of numbers. The chart features of Excel are very rich and this unit can only give a simple introduction. 
P.72 Making Charts
 

Have students create a chart by pressing the Chart Wizard icon in the Formatting toolbar. Depending on how technical your students are, you may like to explain the uses of some of the different types of graph. For example, engineering or science students are likely to better understand the uses of the different types.

Column chart: A column chart shows data changes over a period of time or illustrates comparisons among items. 
Bar chart: A bar chart shows comparisons among individual items. Bar charts have the following chart sub-types. In a column chart, the rectangles are vertical. In a bar chart, they are horizontal.

Line chart: A line chart shows changes in data at equal intervals. They are often used to show changes over time.

Pie chart: A pie chart shows the size of items that make up a data series proportional to the sum of the items. A pie chart shows only one data series. It is very useful when you want to highlight an important element in the data as the visual impact of the pie slices is very strong.
Give students some time to explore the types of graph. Remind them to point the mouse to display the hint/tip boxes.

P.73 Activity: Calculate costs and profit

This activity asks students to think about the costs that their imaginary business faces. You may like to give some sample figures as many students will have no idea at all of how much things like rent and electricity cost. Give the students some time to work alone and then have compare their costs with other students. It is probably most realistic if they list all of their costs on a per month basis.

Have them enter their costs into Excel in two columns, something like this:

Rent


$3,000


Loan repayments
$1,200

etc. 

P.74 Using Pie Charts to show costs
 

Although there are many options in Excel for creating different kinds of graph, the procedure can generally be considered to follow the four steps outlined on page 74 and 75. 

Choose chart type and sub-type

Demonstrate how the chart type is chosen from the options on the left and how the sub-type is chosen on the right.

Choose data range

The easiest way to set the data range is to select the appropriate cells with the mouse before pressing the chart wizard button. If you have already started the chart wizard, the data range can also be selected by pressing the button on the right hand side of the “Data range”.

Decide on legends, data labels, title and other options

A “legend” is a box next to the chart explains what each item in a chart means. Data labels are data descriptors which are appear next to the points on a line graph or the segments of a pie graph etc. 

Give students some time to explore these options.
Choose location of chart

The chart can be placed on the existing sheet, on a different sheet or in a new workbook. In the simple examples in this chapter, it is most straightforward if students place it on the same worksheet. They can move it around easily later.

Have students follow the example on page 74 and 75 to make a pie chart of the costs that they entered for their own company on page 73. 
P.75 Changing patterns and colours


Just about every aspect of a chart is customizable in Excel. The best way to learn about these options is to explore. Try clicking different parts of the graph and see what options are available. Give students some time to explore how they can change colours, patterns, line thickness etc. 

P.76 Line graphs to show changes over time

Have students make a line graph to show the change in their sales over time. If they no longer have that file (or didn’t complete it), tell them to use the sample data for Jeepers Jam from the website.
 

P.76 Complete company charts
 

You may like to have students make other charts for their companies. For example, they could make:

· a pie chart showing the sales divided by product

· a line graph showing the change in prices over time

They can use these graphs in their company report in the next unit.

Unit 9
The company report in this unit provides a great way to consolidate all the work that students have done. It is also a way to grade students on their work.
P.78 Company reports
 

Page 78 shows a sample company report. Of course, it is much simpler than a real company report, which could spread over many pages, but it should still provide a good picture of the company. Students should write the report in Microsoft Word and then import the graphs into the Word document. If you do not have access to Microsoft Word, you could have students write the report by hand and paste the text and the graphics onto paper or a poster.
P.79 Exporting data from Excel into Word

Students need to export their graphs from Excel into the Word document report. They can do this in several ways. 

Cut/Paste

Until now, students have probably only been cutting and pasting simple data such as the contents of a simple cell. Copying and pasting the graph demonstrates that even complex objects and chunks of data can be easily copied. However, depending on your version of Excel, a simple “Copy and Paste” may not retain all the data (or ability to edit that data) when you transfer between Excel and Word. 

Paste Special

Students learned about the Paste Special command on page 69. Depending on your version of Excel, it may be necessary to use this command rather than the regular “Paste” if you wish to be able to edit the Excel graph within the Word document. Have students explore both options to note any differences. 
Insert File or Object
 

Another way to maintain a link between the Word and Excel documents is to use “Insert Object”. Give students some time to try this option, too. You can also take this opportunity to explore the Insert Menu in more detail as it provides many useful options.
P.80 Beginning your company report
 

This section brings together all the work that students have done since unit 2.
P.80 Market research project
 

This is an extra project that you can do if time is available. It is not a necessary part of the company report, but does make it a lot more interesting. 

Finishing the reports

Have students print out their reports. They can paste it into their books, or submit it to the teacher for assessment. You could also have them print out their report and use it as the basis for presentations. If they print it out in a large size, they can use it for poster presentations.

Unit 10
This unit gives students an opportunity to share their report in various formats. Depending on the facilities available to you, you may or may not be able to do activities such as saving to a website. However, it is useful to let students be aware of these functions. 
P.84 Sharing your company report

Sending a workbook by email

A good way to carry out this activity is to have students email their workbooks to each other to get peer feedback. Then they can email it to you as their final assignment. Depending on available time, you could also use this activity to demonstrate and practice the comment features of Excel. These are accessible from the Insert menu.

Saving a workbook as a web page

If your class has a website, have the students save their workbooks as webpages. If you wish, you could also have students use the webpage to make short reports about their companies to the whole class. 

P.85 Exporting Excel data into other formats

Most people will never need to use most of these export formats. The most useful ones are probably:

- CSV (a file where the data from each column is separated by a comma). This type of file can be imported into many other programs.

- Template: This allows students to save a commonly used workbook type in a reusable format. For example, if accounts for each month have to be in a separate workbook, setting up a template would make a lot of sense.

- Excel 97-2004:Many people still have older versions of Excel. If the file is created in a new version of Excel such as Microsoft Office 2008, it will have to be exported in this format for older versions of Excel to be able to read it.
P.86 Setting your preferences

This is an exploration activity. There are hundreds of different ways to configure Excel and all that teachers can do is to make students aware that it is customizable. 
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